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1 Workflow

1.1 Overview

É
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Prepress stage

At the prepress stage a ppf file is generated for the
print job and transferred to the hard disk of the
PC PrepressInterface.

PC with PrepressInterface V2.X

PrepressInterface-V2.X calculates the area coverage
per ink zone for all colors and writes these values
automatically to the cdk file (directory D:\CPC32Dir).

PC with PrepressInterface V3.X

PrepressInterface V3.X calculates the area coverage
per ink zone for all colors and writes these values
automatically to the ppf file (directory
D:\PPFOUT\SMXX).

Plate Image Reader

With the plate image reader a printing plate is mea-
sured, an fdw file (area coverage per ink zone for all
colors) is generated and the latter is transferred to
the hard disk of the PC Plate Image Reader.

PC with Plate Image Reader Online

The fdw files (area coverage per ink zone for all col-
ors) from the Plate Image Reader are filed on the
hard disk (directory D:\CPC31Dir) and are available
to the CP2000 Center of the printing press.

CP2000

The CP2000 Center of the printing press has direct
access to the hard disks of the PC’s with Plate Image
Reader Online (fdw files), PrepressInterface V2.X
(cdk files) and PrepressInteface V3.X (ppf files) and
can thus ”fetch” the requisite area coverage per ink
zone for the relevant print job. In addition the
CP2000 Center has access to the print jobs of other
CP2000 Centers in the network.
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1.2 Hardware prerequisites

Hardware PrepressInterface
(exclusive installation)

Plate Image Reader Online
(exclusive installation)

PrepressInterface and
Plate Image Reader Online
(joint installation)

Processor Pentium processor, clock fre-
quency at least 100 MHz,
recommended 333 MHz

Pentium processor, clock fre-
quency at least 100 MHz,
recommended 333 MHz

Pentium processor, clock fre-
quency at least 100 MHz,
recommended 333 MHz

Main memory At least 128 MByte RAM,
recommended 256 MByte
RAM

At least 64 MByte RAM At least 128 MByte RAM,
recommended 256 MByte
RAM

Graphic dis-
play adaptor

At least 4 Mbyte memory,
resolution at least 1024 x 768
pixels with 32768 colors

VGA graphic display adaptor At least 4 Mbyte memory,
resolution at least 1024 x 768
pixels with 32768 colors

Hard disk At least 4 GByte for operat-
ing system, application and
utility data

At least 4 GByte for operat-
ing system, application and
utility data

At least 4 GByte for operat-
ing system, application and
utility data

Network
board

Ethernet adapter for connec-
tion to the prepress stage
and to the printing presses

Ethernet adapter for connec-
tion to the printing presses

Ethernet adapter for connec-
tion to the prepress stage
and to the printing presses

Monitor Monitor with a resolution of at
least 1024 x 768 pixels

VGA monitor Monitor with a resolution of at
least 1024 x 768 pixels

Interfaces A parallel interface for con-
nection of the external CPC
job memory card drive and of
the PrepressInterface dongle

A serial interface (RS232) for
online connection of the
Plate Image Reader

A parallel interface for con-
nection of the external CPC
job memory card drive and of
the PrepressInterface dongle
and
a serial interface (RS232) for
online connection of the
Plate Image Reader

Other equip-
ment

Keyboard, mouse, 3.5” disk
drive, CD ROM disk drive

Keyboard, mouse, 3.5” disk
drive, CD ROM disk drive

Keyboard, mouse, 3.5” disk
drive, CD ROM disk drive

Tab. 1

Information
All hardware components must comply
with the MS Windows NT Hardware
Compatibility List.
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1.3 Software prerequisites

PrepressInterface CIP3
(exclusive installation)

Plate Image Reader Online
(exclusive installation)

PrepressInterface CIP3 and
Plate Image Reader Online
(joint installation)

Windows NT 4.0 Server and ser-
vice pack 3 (or higher)

Windows NT 4.0 Workstation and
service pack 3 (or higher)

Windows NT 4.0 Server and ser-
vice pack 3 (or higher)

Windows 2000 Professional or
Server

Windows 2000 Professional or
Server

Windows 2000 Professional or
Server

Tab. 2

Information
No other programs are allowed to be
installed on the PC.
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1.4 Installation guidelines Windows NT 4.0 for the PC Plate Image Reader Online/PrepressInterface

Partitioning of the hard disk

The hard disk is subdivided into two parts:

� Partition C:\, max. 1 GB, for the system soft-
ware.

� Partition D:\, for the application software.

Both partitions must be formatted as per the NTFS
file system.

PC name

Use the following designations as PC names.

Information
The PC name always consists of
15 characters.
”XXXXXX” stands for the press serial
number.

� Plate Image Reader Online only on the PC:
HDE31_ _ _ _XXXXXX

� PrepressInterface CIP3 only on the PC:
HDE32_ _ _ _XXXXXX

� Plate Image Reader Online and Prepress-
Interface CIP3 on the PC:
HDE3X_ _ _ _XXXXXX

The PC has to be allocated to the work group HDM
(not to a domain).

User

Set up three users:

� User with administrator rights for the system
administrator of the print shop
(user name and customer’s freely selectable
password).

� User with administrator rights for the HDM ser-
vice
(user name: HD_Service, password: HDM). 

� User for the operator 
(user rights only, user name and customer’s
freely selectable password).

Operating system

If the NT 4.0 Server version is installed, the PC must
be set up as a ”stand–alone server”.
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If Windows 2000 is installed, the PC is set up as
standard as a ”stand–alone server”.

Protocols

� For network variants 1...3 use the protocol
NETBEUI.

� For network variants 4 and 5 use protocols
NETBEUI and TCP/IP, protocol NETBEUI being
required only for name resolution.
For these variants the PC must be set up as a
DHCP client.

A fixed IP address can also be input on the CP2000
Center (from software CPT 034.0 onwards).

1.5 Installation sequence

� Install and start Plate Image Reader Online
and/or PrepressInterface CIP3

� Perform function test on Plate Image Reader
Online and/or PrepressInterface CIP3.

� Make and test network connections between
PC Plate Image Reader Online/Prepressinter-
face CIP3 and CP2000 Center of the printing
press.

� On CP2000 Center of the printing press per-
form the PresetLink setting.

� Perform PresetLink function test.
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2 Network variants

2.1 General

The five network variants are described in detail in
the Technical Information SM 102.

A short list of the most important features of the net-
work variants can be found on the following pages.

2.2 Variant 1

CP2000 Center
PC

Plate Image Reader Online/
PrepressInterface

NETBEUI

To building network

Fig. 2 Variant 1

A maximum of two HDM devices reside in the print
shop, these being erected in the immediate vicinity
(max. 100 m) of one another. They are connected by
a ”reversed” Ethernet cable (with RJ45 connectors).

Communication between the devices is effected via
the NETBEUI protocol.

Only Plate Image Reader Online and/or Prepress-
Interface CIP3 may be installed on the PC.

If PrepressInterface-CIP3 is installed, via a second
network board in the PC Plate Image Reader Online/
PrepressInterface a connection to the building net-
work can be made (the protocol is prespecified by
the building network).
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2.3 Variant 2

CP2000 Center

NETBEUI

CP2000 Center

CP2000 Center

CP2000 Center

HUB
PC

Plate Image Reader Online/
PrepressInterface

To building network

Fig. 3 Variant 2

Several HDM devices are located in the print shop,
these being erected in the immediate vicinity (max.
100 m) of one another. They are connected via a
HUB with Ethernet cables (1:1, i.e. ”non–re-
versed”).

Communication between the devices is effected via
the NETBEUI protocol.

Only Plate Image Reader Online and/or Prepress-
Interface CIP3 may be installed on the PC.

If PrepressInterface-CIP3 is installed, via a second
network board in the PC Plate Image Reader Online/
PrepressInterface a connection to the building net-
work can be made (the protocol is prespecified by
the building network).
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2.4 Variant 3

CP2000 Center

NETBEUI

CP2000 Center

CP2000 Center

CP2000 Center

HUB

PC
 Plate Image Reader Online/

PrepressInterface

Building network

Fig. 4 Variant 3

Already existent in the print shop is a network into
which the HDM devices are directly integrated.

Communication between the devices is effected via
the NETBEUI protocol.

All HDM devices must be linked in a network seg-
ment, because the protocol NETBEUI is not routing–
capable (i.e. communication via different segments is
not possible).

In addition other protocols can be installed for the
network board in the PC Plate Image Reader Online/
PrepressInterface. Communication with Prepress
devices is rendered possible by this means.
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2.5 Variant 4

CP2000 Center

TCP/IP

CP2000 Center

CP2000 Center

CP2000 Center

HUB

PC
Plate Image Reader Online/

PrepressInterface

DHCP-Server
WINS-Server

Building network

Fig. 5 Variant 4

Already existent in the print shop is a network into
which the HDM devices are directly integrated.

Communication between the devices is effected via
the TCP/IP protocol.

As the press CP2000 Centers are set up as DHCP
clients, a DHCP server must be present or be set up
in the network.

Besides this a WINS server must be provided or be
set up in the network.

DHCP and WINS server can be set up together on
one PC.
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2.6 Variant 5

CP2000 Center

TCP/IP

CP2000 Center

CP2000 Center

CP2000 Center

HUB

PC
Plate Image Reader Online/

PrepressInterface

Building network

Router
DHCP-Server
WINS-Server

HUB

Fig. 6 Variant 5

One or several HDM devices are separated from an
already existent printer network by an in–line Router.

Communication between the devices is effected via
the TCP/IP protocol.

As the press CP2000 Centers are set up as DHCP
clients, a DHCP server must be present or must be
set up (on the router PC).

Besides this a WINS server must be present or must
be set up (on the router PC).
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3 Setting up the server

3.1 Hardware and software requirements

Operating system

Microsoft Windows NT 4.0, English server version
with service pack 5 or higher.

Hardware

Processor Pentium II processor, minimum
clock frequence: 200 MHz, recom-
mended: 400 MHz

Main me-
mory

Minimum: 64 MByte RAM,
Recommended: 128 MByte RAM

Graphic dis-
play adaptor

VGA graphic display adaptor

Hard disk Minimum: 4 GByte

Network
card(s)

Ethernet adapter

Monitor VGA monitor

Other equip-
ment

Keyboard, mouse, 3.5” disk drive,
CD ROM disk drive

Tab. 3

Information
All hardware components must comply
with the MS Windows NT Hardware
Compatibility List.
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3.2 Setting up the DHCP server (for network versions 4 and 5)

� Switch on the PC, push the buttons Ctrl, Alt
and Del simultaneously when prompted and
register as auser with administrator rights.

� Insert the NT4.0 CD into the disk drive.

1

2

3

4

Fig. 7 Network Service

� Open the ”Control Panel” dialog box by clicking
the buttons Start>Settings>Control Panel.

� Click on the Networksymbol (Fig.7/1).

� Click Services on the property tab (Fig.7/2).

� Click on the Addbutton (Fig.7/3).

� Click on the Microsoft DHCP Server line
(Fig.7/4). 

� Click on the OK button.

	 Click on the Continuebutton.


 Confirm the appearing message by clicking the
OK button.
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Fig. 8 TCP/IP Properties

� ClickProtocols (Fig. 8/1) on the registration
card.

� Click on the line TCP/IP Protocol (Fig. 8/2).


 Click on the Properties button (Fig.8/3).

� If two network boards are installed in the PC
(network version 5), click on the 84 button in
the drop–down list box ”Adapter” and then click
on the network board to the HDM network [1].

Information
The network board to the HDM net must
be installed as the first [1] network board
and the network board to the in–house
network must be installed as the second
[2] one

� Input on the line ”IP address” (Fig. 8/5):
172.17.50.100
Input on the line ”Subnet Mask” (Fig. 8/6):
255.255.255.0

� Click on the OK button.
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Fig. 9 Bindings

Information
The steps �...� must only be carried
out for the network version 5 (PC with
two network boards).

� Click on the property tab Bindings (Fig. 9/1).

� Click on the button in the line ”Show Bind-
ings” and then click on the line all adapters
(Fig. 9/2).

� Double click both network boards (Fig. 9/3).

� Regarding the network board to the in–house
network, click on the line TCP/IP Protocol
(Fig. 9/4).

� Click on the Microsoft DHCP Server line
(Fig.9/5).

� Click on the Disable button (Fig. 9/6).

� Click on the Close button.

� Click on the Close button.

� Remove the NT4.0 CD from the disk drive.

� Click on the Yes button.

Information
The PC is restarted.

� Upon request, push the buttons Ctrl, Alt and
Del simultaneously and register as a user with
administrator rights.

1
2

3

4

Fig. 10 Create Scope

� Open the ”DHCP Manager” dialog box by click-
ing the buttons Start>Programs>Administra-
tive Tools>DHCP-Manager.

� Double Click on the line local press.

� Click Scope>Create in the menu bar.

� Input on the line ”Start Address” (Fig. 10/1):
172.17.50.1
Input on the line ”End Address”(Fig. 10/2):
172.17.50.99
Input on the line ”Subnet Mask”(Fig. 10/3):
255.255.255.0

 Set 
Limited to 42 Days in the field ”Lease Dura-
tion” (Fig. 10/4).

! Click on the OK button.

" Click on the Yes button.

# The following display may appear: ”No more
data available”. Confirm this message by click-
ing on the OKbutton.

Information
In case of network version 5 the steps in
the following chapter must be carried out
additionally.
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$ Close the ”DHCP Manager” dialog box by click-
ing the     button.
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3.3 Setting up the DHCP Server (additional step, only for network version 5)

1

3

2

4 5

6

8
9

7

Fig. 11 DHCP Options, WINS/NBNS

% Click DHCP Options>Global in the menu bar
(Fig. 11/3).

& In the window ”DHCP Options: Global” click on
the option 044 WINS/NBNS Servers
(Fig. 11/4).

' Click on the Add button (Fig. 11/5).

( Confirm the appearing message by clicking the
OK button.

) Click on the Value button (Fig. 11/6).

* Click on the Edit Array button (Fig. 11/7).

+ Enter 
172.17.50.100 (Fig. 11/8) in the line New IP Ad-
dress.

, Click on the Add button (Fig. 11/9).

- Click on the OK button.



   
   

   
G

R
 C

P
18

60
44

90
00

00
00

00
   

   
   

G
R

 C
P

18
60

45
00

00
00

00
00

Network

A.1.20

1 2

3

4

Fig. 12 DHCP Options, WINS/NBT

. In the window ”DHCP Options: Global” click on
the option 046 WINS/NBT Node Type
(Fig. 12/1).

/ Click on the Add button (Fig. 12/2).

0 Click on the Value button (Fig. 12/4).

1 In the line Byte, enter 0x8 (Hybid-node,
Fig. 12/3).

2 Click on the OK button.

1

2 3

4
5

6
7

Fig. 13 DHCP Options, Router

3 Click DHCP Options>Global in the menu bar
(Fig. 13/1).

4 In the window ”DHCP Options: Global” click on
the option 003 Router (Fig. 13/2).

5 Click on the Add button (Fig.13/3).

6 Click on the Value button (Fig.13/4).

7 Click on the Edit Array button (Fig.13/5).

8 Enter 
172.17.50.100 (IP address 0f the router)
(Fig.13/6) in the New IP Address line.

9 Click on the Add button (Fig.13/7).

: Click on the OK button.

; Click on the OK button.

< Close the ”DHCP Manager” dialog box by click-
ing the     button.
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3.4 Setting up the DHCP client

1

Fig. 14 TCP/IP Properties

� Insert the NT4.0 CD into the disk drive.

� Open the ”Control Panel” dialog box by clicking
the buttons Start>Settings>Control Panel.

� Click on the Network symbol.

� Click on the property tab Protocols.

� Click on the Add button.

� Click on the line TCP/IP Protocol.

� Click on the OK button.

� Display: ”Do you wish to use DHCP?”
Click on the Yes button.

	 Click on the Continuebutton.


 Click on the Close button.

� Click on the circle in front of the line ”Obtain an
IP address from a DHCP Server” (Fig. 14/1).

Information
A point must appear in the circle.

� Display: Do you want to enable DHCP?
Click on the Yes button.


 Click on the OK button.

� Remove the NT4.0 CD from the disk drive.

� Click on the Yes button.

Information
The PC is restarted.
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3.5 Setting up the WINS server (for network versions 4 and 5)

� Switch on the PC, push the buttons Ctrl, Alt
and Del simultaneously upon request and regis-
ter as auser with administrator rights.

� Insert the NT4.0 CD into the disk drive.

1

2

3

4

Fig. 15 Network Service

� Open the ”Control Panel” dialog box by clicking
the buttons Start>Settings>Control Panel.

� Click on the Network symbol (Fig. 15/1).

� Click Services (Fig. 15/2) on the property tab.

� Click on the Addbutton (Fig. 15/3).

� Click on the line Windows Internet Name Ser-
vice (Fig. 15/4). 

� Click on the OK button.

	 Click on the Continuebutton.


 Click on the Close button.

� Remove the NT4.0 CD from the disk drive.

� Click on the Yes button.

Information
The PC is restarted.
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Information
The address of the WINS server
(TCP/IP Properties/WINS Address) must
be entered in all the PCs in the in–house
network which have access to the HDM
network. Moreover, the router address
must be defined on all these PCs (only
for the network version 5).
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3.6 Setting up the router (for network version 5)

� Switch on the PC, push the buttons Ctrl, Alt
and Del simultaneously upon request and regis-
ter as auser with administrator rights.

6
1

2

3

4

5

Fig. 16 TCP/IP Properties

� Open the ”Control Panel” dialog box by clicking
the buttons Start>Settings>Control Panel. 

� Click on the Network symbol (Fig. 16/1).

� Click Protocols (Fig. 16/2) on the property tab.

� Click on the line TCP/IP Protocol (Fig. 16/3).

� Click on the Propertiesbutton (Fig. 16/4).

� Click Routing (Fig. 16/5) on the property tab.

� Click on the rectangle in front of the line
Enable IP Forwarding (Fig. 16/6).

Information
A check mark must appear in the rectan-
gle.

	 Click on the OK button.


 Click on the Close button.
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� Click on the Yes button.

Information
The PC is restarted. No CD must be in
the disk drive.
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3.7 TCP/IP accessories

The following TCP/IP utility programs can be used
for checking the network (start via the MS DOS input
window).

3.7.1 ipconfig

Fig. 17 ipconfig

The utility program ipconfig serves to display the IP
configuration of the installed network boards
(Fig. 17):

� IP Address

� Subnet Mask

� Default Gateway

3.7.2 ping

Fig. 18 ping / connection ok.

Fig. 19 ping / no connection
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The utility program ping serves to check the connec-
tion (only for the TCP/IP protocol) to other computers
in the network.

� Fig. 18: Connection OK.

� Fig. 19: No connection could be made.

3.7.3 tracert

Fig. 20 tracert

The utility program tracert serves to check the path
(via Router) of a data packet to a specific computer
(Fig. 20).
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1 Set up the Plate Image Reader online connection

1.1 Installation sequence

� Connect Plate Image Reader to the PC.

� Install the software Plate Image Reader Online.

� Enable directory CPC31Dir.

� Activate user account ”Guest”.

� Check installation.

� Make a note of the path for CP2000.

� Check the network connection to the CP2000
Center.

1.2 Connect Plate Image Reader to the PC

1

Fig. 1 Plate Image Reader

� Plug the connection cable into the serial inter-
face (RS 232) on the underside of the Plate
Image Reader (Fig. 1/1).

Information
The connection cable is included in the
supply scope of the Plate Image Reader
Online kit.

� Plug the connection cable into a serial interface
(RS 232), COM1 or COM2 of the PC.

Information
The Plate Image Reader can now be
switched on. The Plate Image Reader
detects the connection to the PC as
soon as the Plate Image Reader Online
is started on the PC.

1.3 Installing the Plate Image Reader Online software

The software installation is described in the operat-
ing manual Plate Image Reader Online Kit.
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1.4 Enabling directory CPC31Dir

The directory CPC31Dir is generated during installa-
tion of the online kit and must be enabled for
CP2000 Center access to the fdw files.

2
8

3

4

6

7

1

5

Fig. 2 Enabling the directory

� In Explorer click on the directory CPC31Dir
(Fig. 2/2).

Information
The directory must be backed up.
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� On the menu bar click on File>Properties
(Fig. 2/1).

� Click on the tab Sharing (Fig. 2/4).

� Click on the circle in front of Shared As
(Fig. 2/3).

Information
A dot must appear in the circle.

Information
The ”Share Name” (directory) specified
here must later be entered for Preset-
Link (CP2000).

� Click on the Permissions... button (Fig. 2/6).

� Checking the setting:
in the window ”Access Through Share Permis-
sions” the group Everyone must be allocated
the access type Full Control (Fig. 2/7). 

� Click on the OK button.

� Click on the OK button.

Information
The directory CPC31Dir must now dis-
play a hand (Fig. 2/8).
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1.5 Activating the user account ”Guest”

The user account ”Guest” must be activated for the
CP2000 Center to access the fdw files (area cover-
age per ink zone).

1

2

3

Fig. 3 User manager

� By clicking on the buttons Start>Pro-
grams>Administrative Tools> User Manager
for Domains open the window ”User Manager”.

� Double click on the line Guest (Fig. 3/1).

� Delete the entries on the lines Password and
Confirm Password (Fig. 3/2).
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� By clicking on the rectangle in front of the line
Account Disabled (Fig. 3/3) remove the tick.

Information
The CP2000 Center cannot access the
PC Plate Image Reader Online/Prepres-
sInterface as long as the ”Guest” ac-
count is deactivated.

� Click on the OK button.

� Close the window ”User Manager” by clicking
on the  button.

1.6 Checking the installation

1.6.1 Checking the data transfer

1

2

3

Fig. 4 Plate Image Reader control console

� Start Plate Image Reader Online on the PC.

� Switch on the Plate Image Reader.

� Press the button Job preparation (Fig. 4/1).

� Press the button for PC memory (Fig. 4/2).

Information
The symbol PC memory (Abb. 4/3) must
have a highlighted background and is
not allowed to be flashing.

� Perform a measuring run and transfer the fdw
file to the PC memory.

Information
See operating manual Plate Image
Reader Online.

� Check the file:
Start Explorer, the relevant fdw file must be
filed in the directory CPC31dir.



   
   

   
G

R
 C

P
18

60
42

00
00

00
00

00

   
   

   
G

R
 C

P
18

60
42

10
00

00
00

00

PresetLink

A.2.8

1.6.2 Checking the entries in the registry 

1

Fig. 5 Run

� By clicking on the buttons Start>Run open the
window ”Run”.

� Input: regedit

� Click on the OK button.

1

2

3
4
5

Fig. 6 Registry editor

� In the registry editor open the directory
CPC31Server (Fig. 6/1)
(path: HKEY_LOCAL_MACHINE\
SOFTWARE\Heidelberger Druckmaschinen
AG\JobPreparation\Devices).

� Check entries in accordance with Fig. 6/2.
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1.6.3 Effecting changes in the registry

If any changes in the registry are required, proceed
as follows:

Be careful
Thoughtless changes can prevent the
perfect operation of the PC.
All changes are effective immediately
(i.e. without an ’Are you sure’ query).

2
1

Fig. 7 Edit PUORD value

� Terminate the program Plate Image Reader On-
line before the changes.

Changing the quantity of files in the directory

� Double click on the line MaxDirSize (Fig. 6/3).

� Click on the circle in front of Decimal (Fig. 7/1).

Information
A dot must appear in the circle.

� On the line Value Data (Fig. 7/2) enter the ap-
propriate value.

Information
As only eight files (jobs) can be dis-
played simultaneously on the CP2000
user interface in the submenu ”Memory
management”, this value should be set
to a max. of 100 to provide a better over-
view.

� Click on the OK button.

Path input

The path input change for the export directory of the
fdw files (C:\CPC31Dir) can be effected here
(Fig. 6/4).

1

Fig. 8 Edit string

Changing the port (serial interface)

� Double click on the line Port (Fig. 6/5).

� On the line Value Data change the entry to
COM1 or COM2 (Fig. 8/1).

� Click on the OK button.

� After the changes start the program Plate
Image Reader Online.
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1.7 Making a note of the path for CP2000

� Making a note of the path for CP2000
(CPC31Dir)

Information
On the CP2000 Center the path in which
the fdw files are filed must later be speci-
fied. The path consists of the name of
the PC and the enable name of the di-
rectory:
\\PC_name\enable_name

1.8 Checking the network connection to the CP2000 Center

� On the PC Plate Image Reader Online via the
window ”Network Neighborhood” check the
connection to the CP2000 Center.

Information
All CP2000 Centers must be displayed
in the work group HDM.

1.9 Troubleshooting

Error symptom Possible cause Error elimination

Symbol PC memory on Plate
Image Reader flashing
(connection to Plate Image

Plate Image Reader Online on the
PC has not started.

Start Plate Image Reader Online
on the PC.Image Reader flashing

(connection to Plate Image
Reader is interrupted). Serial cable on the PC not con-

nected or wrongly plugged in
(wrong serial interface).

Check connection of the serial
cable to the PC.

Wrong serial interface set in the
registry.

Check the registry (serial inter-
face).

Symbol PC memory does not ap-
pear on the Plate Image Reader.

Plate Image Reader does not de-
tect that the serial interface is oc-
cupied.
Serial cable on the Plate Image
Reader is not connected or is in-
correctly connected.

Check the serial cable to the PC,
internal serial cable in the Plate
Image Reader, Plate Image
Reader expansion board PEK in
the Plate Image Reader and all
plug connections.

On the PC Plate Image Reader
Online in the directory CPC31Dir
no fdw files exist or the fdw files
are filed in the wrong directory.

No path specification exists or
there is a wrong path specification.

Check the path specification in the
registry.

Tab. 1

1.10 General

The Plate Image Reader does not have to be
switched on again, if the serial interface
(COM1/COM2) is changed over.
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2 Setting up the PC PrepressInterface

2.1 General

See chapter ”Setting up the CP2000 Center, over-
view of the possible configurations”

2.2 Procedure for PPF files/end devices

2.2.1 Installation sequence

� Install the PrepressInterface software (V3.X).

� Set up the end devices.

� Enable the directory PPFOUT or end device
directory (e.g. PPFOUT\SM74).

� Activate the user account ”Guest”.

� Check the installation.

� Make a note of the path for the CP2000 Center.

� Check the network connection to the CP2000
Center.

2.2.2 Installing the PrepressInterface software (V3.X)

The software installation is described in the operat-
ing manual PrepressInterface (V3.X).

2.2.3 Setting up the end devices

� Start the process editor.
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1

Fig. 9 Process editor

� In the box Process Data select an existing input
directory or a new input directory.

� To draw up a new input directory click on
the button New (Fig. 9/1).

Fig. 10 New input directory

� Enter the name of the new input directory and
save it by clicking on the  button.
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1

Fig. 11 Process editor

� In the box ”Configured end devices” click on the
button ”New” (Fig. 11/1).
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1
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4

Fig. 12 Defining an interface

� Select the name of the interface description
(CP2000 Center or ImageControl, Fig. 12/1))

� Enter the name of the end device (e.g. designa-
tion of the printing press, SM 74) (Fig. 12/2).

� In Explorer create the directory
D:\PPFOUT\SM74.

Information
When setting up the CP2000 enter the
appropriate paths for each press.

� Open window (Fig. 12/3).

	 Open directory D:\PPFOUT\SM74 and confirm
with the button. 


 Save input with the  button (Fig. 12/4).

1

Fig. 13 Activating the end device interface

� Activate the end device interface by clicking on
the rectangle (active with tick, Fig. 13/1).

2.2.4 Enable directory PPFOUT or end device directory (e.g. PPFOUT\SM74)

See chapter ”Setting up the Plate Image Reader on-
line connection, enabling the directory CPC31Dir”.

2.2.5 Activating the user account ”Guest”

See chapter ”Setting up the Plate Image Reader on-
line connection, activating the user account ”Guest”.
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2.2.6 Checking the installation

� Start the program PrepressInterface by clicking
on the buttons Start>Programs>Prepress-
Interface

� Process the ppf file.

� Check the file:
Start Explorer, the appropriate ppf file must be
filed in the directory for the end device (e.g.
\..\SM74).

Information
The file can be identified on the basis of
the date and time.

2.2.7 Making a note of the path for CP2000

� Make a note of the directory path
PPFOUT\SM74 for CP2000.

Information
The path must later be specified on the
CP2000 Center in which the ppf files are
filed. The path consists of the PC name
and the directory enable name:
\\PC_name\enable_name

2.2.8 Check the network connection to the CP 2000 Center

� Check the connection to the CP 2000 Centers
on the PC PrepressInterface via the window
”Network Neighborhood”.

Information
All CP2000 Centers must be displayed
in the work group HDM.

2.3 Procedure with cdk files

2.3.1 Installation sequence

� Install the PrepressInterface software (V3.X).

� Create a directory for cdk files.

� Enable the directory CDK_FILES.

� Activate the user account ”Guest”.

� Enter the directory in the registry.

� Check the installation.

� Make a note of the path for CP2000.

� Check the network connection to the CP2000
Center.

	 Activate the DataControl-PresetImage/preview
mask
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2.3.2 Installing the PrepressInterface software (V3.X)

The software installation is described in the operat-
ing instructions PrepressInterface (V3.X).

2.3.3 Creating the directory for cdk files

� In Explorer set up the directory D:\CDK_FILES
(menu bar, File>New>Folder).

2.3.4 Enabling the directory CDK_FILES

See chapter ”Setting up the Plate Image Reader on-
line connection, enabling the directory CPC31Dir”.

2.3.5 Activating the user account ”Guest”

See chapter ”Setting up the Plate Image Reader on-
line connection, activating the user account ”Guest””.

2.3.6 Entering the directory in the PrepressInterface RegistryEditor

1

2

3

D:\CDK_FILES

Fig. 14 RegistryEditor

� To start the program RegistryEditor: click on the
buttons Start>Programs>Prepress-
Interface>Administration>RegistryEditor.
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� In the directory PrepressInterface click on the
entry DataControl-PresetLinkPath (Fig. 14/1).

� Click on the Browse button (Fig.  14/2).

� Double click on the directory D:\CDK_FILES.

� Click on the  button.

� Click on the Write Value button (Fig.  14/3).

� Terminate the ”RegistryEditor” by clicking on the
 button or on the  button.

2.3.7 Checking the installation

� To start the program PrepressInterface: click on
the buttons Start>Programs>Prepress-
Interface>Prepressinterface.

� Process the ppf file.

� Check the file:
Start Explorer, the appropriate cdk file must be
filed in the directoryCDK_FILES.

Information
The file can be identified on the basis of
the date and time.

2.3.8 Making a note of the path for CP2000

� Make a note of the path of the directory
CDK_FILES for CP2000.

Information
On the CP2000 Center the path in which
the cdk files are filed must later be speci-
fied. The path consists of the PC name
and the directory enable name:
\\PC_name\enable_name

2.3.9 Checking the network connection to the CP 2000 Center

� Check the connection to the CP 2000 Centers
on the PC PrepressInterface via the window
”Network Neighborhood”.

Information
All CP2000 Centers must be displayed
in the work group HDM.



   
   

   
G

R
 C

P
10

01
02

00
00

00
00

00

PresetLink

A.2.18

2.3.10 Activating the DataControl-PresetImage/preview mask

1

3

2

Fig. 15 RegistryEditor

Information
The function preview mask is available
on the CP 2000 Center from software
version CPT 031.X onwards.

� Start the RegistryEditor.

� Click on the file DataControl-PresetImage
(Fig. 15/1).

� Enter the value 1 (Fig. 15/2).

� Click on the Write Value button (Fig. 15/3).

Nothing has to be set up on the CP2000 Center for
the function preview mask.
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3 Setting up the CP2000 Center

3.1 Overview of possible configurations

Software ver-
sion Prepress-
Interface

Data format Software ver-
sion CPTronic

CPC32 V2.X cdk CPT 030.X
CPT 031.X
CPT 032.X

PPI V3.X cdk CPT 030.X
CPT 031.X
CPT 032.X

PPI V3.X PPF CPT V32.X

Tab. 2

A non–used interface (PrepressInterface, Prepress-
Interface PPF and Plate Image Reader) must be de-
activated (set to 0).

If several presses are to be connected to
DataControl, bear in mind the following:

� if various software versions of the CPTronic or
the software version CPC32 V2.1 of the
PrepressInterface is present, only the data for-
mat cdk can be used.

� if the software version PPI V3 of the Prepress-
Interface is present, the data format cdk must
be set on presses with software versions
CPT 030.X and CPT 031.X. On presses with
software version CPT 032.X the data format
PPF can be used, if the additional use of this
data format is required.

Data formats on the CP2000 Center (data proc-
essing)

PresetLink Software ver-
sion CPTronic

Data format on
the CP2000
Center

CPC32 CPT 030.X
CPT 031.X

cdk

Prepress-
Interface

CPT 032.X cdk

Prepress-
Interface PPF

CPT 032.X PPF

Tab. 3
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Data formats on the PrepressInterface (data gen-
eration)

Software version Prepress-
Interface

Data format

CPC 32 V1.0 cdk

CPC 32 V2.1 cdk

PPI V3.0 PPF or cdk

Tab. 4

3.2 Installation sequence

� Perform the licensing.

Information
The PresetLink licensing is described in
the operating instructions SM 102 /
CD 102 and SM 74 with CP2000.

� Enter the appropriate paths,
e.g. for PrepressInterface PPF:
\\PPFServer\PPFOUT\SM74

Information
Here the paths noted in the chapters
”Setting up the Plate Image Reader on-
line connection” and ”Setting up the PC
PrepressInterface” must be input and the
value ”Enabled” for the option used must
be set to ”1”.

� Restart the CP2000 press.

Information
The press must be restarted after any
change.

� Check whether switched clear.

3.3 Checking whether switched clear

� In the submenu Data source check:
Plate Image Reader or PrepressInterface
must be entered.

� In the submenu Memory management check:
The files (jobs) filed during checking of the
Installation Plate Image Reader/PrepressInter-
face must be displayed.
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3.4 Setting up a ”new data base in the network”

To link up with another press a ”new data base in the
network” can be set up in the PresetLink. To do so
enter the following:

Designation Input

Enabled 1

PlugIn HDev_SheetPress.dll

DeviceName e.g. CD 102-6+L

HostName e.g. HDC0700003338

Tab. 5
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3.5 Designation of the print jobs

1 2 3

Fig. 16 Print jobs

1 Job number

2 Sheet number

3 Job name

Designation of the print job is defined at the prepress
stage, but can be altered as required in the
PrepressInterface Editor.
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3.6 Troubleshooting

Error symptom Possible cause Error elimination

The Plate Image Reader or Plate
Image Reader are not entered in
the submenu Data source.

PresetLink (CP2000 Center) is not
switched clear.

Switch the PresetLink clear.
Image Reader are not entered in
the submenu Data source.

Enabled (CP2000 Center) is set
wrongly or is not set.

Set enabled to ”1”.

In the submenu Memory man-
agement no files (jobs) are dis-
played.

The network connection does not
function.

On the PC Plate Image Reader
Online/PrepressInterface via ”Net-
work Neighborhood” check the
connection to the CP2000 Center
(CP2000 Center must be dis-
played) and check all network
components (connection cable,
router...).
The network represents a further
error source. If any problems oc-
cur, check whether the computers
can ”see” each other.
Causes can be: Wrong data
speed, wrong cable, distances too
great. To ensure the basic
functionality connect the PC
PrepressInterface directly to the
CP2000 Center (with cable re-
versed).

Path wrongly entered in the Pre-
setLink (CP2000 Center).

Correct the path input
(\\PC_name\enable_name).

Directory not enabled or wrongly
enabled on the PC Plate Image
Reader Online/PrepressInterface.

Perform or correct the directory
enable.

User account ”Guest” not set up or
wrongly set up on the PC Plate
Image Reader Online/PrepressIn-
terface.

Activate or correct the user ac-
count ”Guest”.

Preview mask is not shown. Parameter Datacontrol Preset
Image not set in the Prepress-
Interface.

Set the parameter to ”1”.

Tab. 6

Information
After any changes always switch the
press off and back on.
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3.7 Documentation for installation

This form has to be filed in the SSU after installation.

Please fill out

Customer name

Contact person
at the customer’s

PC name Plate Image Reader
Online:

PrepressInterface:

User (with password)
default:
HD_Service (HDM)

Protocols used in the 
network

Network variant
(as per specification)

Path specifications
\\PC name\clearance

Plate Image Reader
Online:

PrepressInterface:

Equipment number Plate Image Reader
Online:

PrepressInterface:

Model designations
and press serial numbers
(CP2000)

Option key / License key
for Preset Link (CP2000)

Service technicians

Tab. 7
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1 Overview

1.1 General information

CP2000 ManagementGate

Workplace In-
terface

(DataControl)

MIS
(vertical market soft-

ware)

or

CP2000 Center

Fig. 1 Linking CP2000 ManagementGate with
MIS or Workplace Interface 

The ”CP2000 ManagementGate” software module is
integrated in printing presses with CP2000 Center
from software version 32.5 onwards. After it has
been enabled, it permits the EDP integration for a
uniform job handling and production data acquisition
(PDA).
The printing presses can be connected to a hierar-
chically higher Management Information System MIS
(trade-specific software system) via an open inter-
face.

CP2000 ManagementGate supports the connection:

� to the Management Information System MIS
(trade-specific software system)

� to Workplace Interface (DataControl)
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1.2 Linking CP2000 ManagementGate to the Management Information System MIS (trade-specific
software system)

MIS (vertical market software)

CP2000 ManagementGate

File server

Job list

Job list
PDA data

CP2000 Center

PDA data

Fig. 2 Job data transfer between
CP2000 ManagementGate and MIS

The interface between CP2000 ManagementGate
and MIS obeys the same conventions as the inter-
face between DataControl and MIS.

The interface is deliberately kept simple. It is based
on a file transfer of ASCII files. MIS can transfer job
data to presses with CP2000 control systems, and
receive PDA data from such a press. This does not
require a DataControl system to be installed at the
customer’s.

When the interface was designed care was taken to
decouple the systems as well as possible. The data
exchange files that can be read and written to with
standard editors facilitate start-up and diagnosis of
the interface. A file transfer mechanism permits dif-
ferent computer worlds to be linked with each other
easily.
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1.3 Linking CP2000 ManagementGate to DataControl

CP2000 ManagementGate

CP2000 Center

Workplace Interface

PDA data,
repetition data

Job list,
presetting data,
repetition data,
area coverage va-
lues

DataControl

Fig. 3 Data transfer between CP2000 Man-
agementGate and the DataControl
Workplace Interface 

CP2000 ManagementGate is linked to DataControl
via the DataControl Workplace Interface. Thus, the
data from the DataControl database (presetting data,
inking unit settings, and repetition data) is available
at the CP2000 Center. The printing press delivers
PDA data to DataControl.

1.4 Configuring CP2000 ManagementGate 

The ”CP2000 ManagementGate” software module is
enabled at the CP2000 Center. It is described under
”Basic adjustment”, ”Additional software modules” in
the operating manual.

Configuring 
software modules

Fig. 4 Key sequence

First invoke the ”Configuring software modules /
Data source” menu (see Figure) to select the link for
the required application.
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Fig. 5 ”Configuring software modules / Data source” service display

Display Meaning

CPCDI Configuration of the link to the printing press SM 74 DI.

DataControl Configuration of the link to DataControl.

Setting up remote device Configuration of the link to another printing press with CP2000 Center.

Management Information’s Sys-
tem

Configuration of the link to a trade-specific software system.

Plate Image Reader Configuration of the link to the printing plate reader.

PrepressInterface Configuration of the link to PrepressInterface in a version smaller than
3.0.

PrepressInterface (PPF) Configuration of the link to PrepressInterface from Version 3.0 onwards
(enhanced scope of the presetting data).

Tab. 1



   
   

   
G

R
 M

G
11

00
00

60
00

00
10

00

ManagementGate

A.3.7

1.4.1 Link to DataControl

Service / Device configuration

12345
Order
name

ÉÉ
ÉÉ
É
É
É

Fig. 6 ”Configuring device” service display with connection to DataControl

Display Default Meaning

Enabled 1: Link to DataControl enabled.
0: Link to the outside disabled.

PlugIn Name of the device DLL, ”HDev_WPI.DLL”.

WP_OperatingTimeOut1 10000 Maximum waiting time (in ms) until an operation must be com-
pleted. Operation is enabled after this time.

WP_Id1 Name of the workplace ID under which DataControl manages
the operator position. The name is ”0” if the operator position
has not yet been created. DataControl assigns the operator posi-
tion an ID upon the first logon.

WP_Name1 Operator position under which CP2000 Center logs on with
DataControl.

WPI_IP_Addr1 IP address of the PC with the Workplace Interface, either as a
name or as a dot-separated numerical sequence.

WPI_Port_No1 TCP/IP port number of the PC that contains the Workplace Inter-
face. Always ”506” with DataControl.
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MeaningDefaultDisplay

WP_CommunicationTimeOut1 60000 Time-out time in ms for the communication between 
ManagementGate and DataControl server.

WP_CodePage 1252 CodePage of the language selection of DataControl. The default
value 1252 corresponds to Europe/America.

WP_ColorPreset Preferred source for the loading process of repeat, color and
presetting data.The default value is CPC1. This means that load-
ing the area coverage values from the CPC1 is preferred. When
”CPC3” is entered, loading the area coverage values from the
pre-press stage is preferred. The other values are used if the
preferred values can not be found.

Tab. 2

1.4.2 Link to the Management Information System MIS

Configuring service / software module

Fig. 7 ”Configuring software modules” service display with connection to MIS, part 1
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Configuring service / software module

Fig. 8 ”Configuring software modules” service display with connection to MIS, part 2
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Configuring service / software module

Fig. 9 ”Configuring software modules” service display with connection to MIS, part 3

Display Default Meaning

Enabled 1: Link to MIS enabled.
0: Link to the outside disabled.

PlugIn Name of the device DLL, ”HDEV_HICo.dll”.

General\MID Cost center number of the press used for allocating the operations
from the job files and for identifying the press in the PDA file.

General\ForeignMIDs A press can access operations from more than one cost center.
Thus, additional cost center numbers can be entered here. The cost
centers can be separated by blanks, commas, or semicolons.

JobFiles\TODC Complete path of the TODC directory.

JobFiles\Retries 10 Number of attempts of opening or deleting a job file.

JobFiles\RetryDelay 500 Delay (in ms) between two attempts of opening a job file.

JobFiles\MaxAge Number of days after which a job file is deleted automatically (even if
it still contains operations).

JobFiles\DirUpdateDelay 30000 Delay (in ms) between the updating processes of the job list.

JobFiles\CodePage 2152 The code page the host system transfers to the documentation inter-
face when the job is loaded.

BDEFile\FileName Name of the PDA file with full path specification.  A PDA file is not
created if this parameter can not be found.
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MeaningDefaultDisplay

BDEFile\TFIntervall 1000 Time interval (in ms) for partly-finished messages that are cyclically
written to the PDA file.

BDEFile\BufferSize 200 Length of the cyclic buffer (in kbytes).

BDEFile\Retries 10 Number of attempts of opening a PDA file.

BDEFile\RetryDelay 500 Delay (in ms) between two attempts of opening a PDA file.

HierarchyMapping\
JobidElem1

First element in ”job number” of CP2000 ManagementGate. Input of
one of the following key words: ”ORDERNO” / ”PRODNO” / ”JOBNO”

HierarchyMapping\
JobidElem2

Second element in ”job number” of CP2000 ManagementGate. Input
of one of the following key words: ”ORDERNO” / ”PRODNO” /
”JOBNO”

HierarchyMapping\
JobidElem3

Third element in ”job number” of CP2000 ManagementGate. Input of
one of the following key words: ”ORDERNO” / ”PRODNO” / ”JOBNO”

HierarchyMapping\
JobidSeparator

Delimiter (one or more printable characters) that separate the ele-
ments in ”job number” of CP2000 ManagementGate.

HierarchyMapping\
JobnameElem1

First element in ”job name” of CP2000 ManagementGate. Input of
one of the following key words: ”ORDERNAME” / ”ORDERNO” /
”PRODNAME” / ”PRODNO” / ”JOBNAME” / ”JOBNO”

HierarchyMapping\
JobnameElem2

Second element in ”job name” of CP2000 ManagementGate. Input of
one of the following key words: ”ORDERNAME” / ”ORDERNO” /
”PRODNAME” / ”PRODNO” / ”JOBNAME” / ”JOBNO”

HierarchyMapping\
JobnameElem3

Third element in ”job name” of CP2000 ManagementGate. Input of
one of the following key words: ”ORDERNAME” / ”ORDERNO” /
”PRODNAME” / ”PRODNO” / ”JOBNAME” / ”JOBNO”

HierarchyMapping\
JobnameSeparator

Delimiter (one or more printable characters) that separate the ele-
ments in ”job name” of CP2000 ManagementGate.

Tab. 3

From software version 034 onwards, the individual
elements of the job hierarchies can basically be allo-
cated to the elements ”job number” and ”job name”
of CP2000 ManagementGate as required. However,
the connection of CP2000 ManagementGate to
DataControl or to MIS requires that the production
data supplied from CP2000 Center can unambigu-
ously be allocated to a job. In CP2000 Management-
Gate, the job number must therefore always be con-
figured such that job number, sheet number and
operation number of DataControl or MIS are con-
tained.  Merely the separators and the job name in
CP2000 ManagementGate can be defined as re-
quired.
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2 Connection of CP2000 Center to the trade-specific software

2.1 Overview

Printing presses with CPTronic control system can
be connected to MIS (trade-specific software) via
DataControl. The definition of the interface between
DataControl and MIS is already described in
”DataControl, interface descriptions, DataControl
order interface / production data (PDA) from
DataControl”. The job data from the MIS can be
transferred to the printing press, production data
(PDA data) can be received.

An adaptation of the interface was performed in or-
der to be able to connect printing presses with
CP2000 control systems directly to the MIS. It is
available with the ”CP2000 ManagementGate” option
package.

The following document describes the peculiarities of
this interface and is based on the above-mentioned
description.
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2.2 Transferring job data from MIS to CP2000 Center

2.2.1 Job files

MIS (vertical market software)

CP2000 ManagementGate

File server

CP2000 Center

Fig. 10 Job file transfer from MIS to
CP2000 Center (example)

Directory in the file server

The computer that contains the trade-specific soft-
ware is called Management Information System
(MIS). The MIS combines job data in files and stores
these files in a directory in the file server. This direc-
tory, which can be chosen as required, must be en-
tered in the CP2000 Center and in the MIS.

Loading a job

The files must be parsed when the press operator
wants to load a job. CP2000 ManagementGate
fetches a list of the jobs that are relevant to this cost
center (operator position). The job list consists of the
jobs where the cost center specified in the trade-spe-
cific software matches the cost center configured at
CP2000 Center.

A job file created by the MIS may contain several
jobs. After a job has been selected from the job list,
the job data and the job docket are transferred. The
job docket is a separate text file that contains addi-
tional information about the print job. Both files with
the job-relevant contents are transferred to
CP2000 Center.

In order to prevent a job from appearing again in the
job list after it has been loaded, the currently loaded
job is removed from the job file. The complete job file
is deleted if it does not contain any other jobs. If the
MIS transfers again a file with a job that has already
been loaded to CP2000 Center, previously loaded
jobs can again be displayed in the job list.

Modification of job data

When the MIS creates a new file upon a modification
of the job data (the number of impressions, for exam-
ple), there are two files for this job. The two files dif-
fer in the creation date (file date). In this case,
CP2000 Center takes the file last changed that con-
tains the modified data, and deletes the older files of
the same job. Consequently, the job lists of
CP 2000 Center and MIS are not synchronized auto-
matically!
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2.2.2 Data format

The data used by CP2000 ManagementGate must
comply with the syntax specified in ”DataControl,
interface descriptions, Orderinterface
DataControl”. Only a part of the transferred data is
processed in CP2000 Center. This data is described
below.

Prerequisites

� CodePage
CodePage in MIS and CP2000 Management-
Gate must be identical in order to obtain a fault-
less representation of the data in CP2000 Man-
agementGate! CodePage can be configured. 

� Cost center number
A job can only be represented in CP2000 Man-
agementGate if the cost center for the printing
press is known and has been transferred in the
file. The cost center can be configured.

� Delimiter
The delimiter used for separating the job ID
must have been configured. 

Job hierarchy

An unequivocal allocation of the job-related data re-
quires the identification of the job to be possible for
MIS / Prepress Interface and for CP2000 Manage-
mentGate. The different depths of the job hierarchies
(MIS 3 levels, Prepress Interface 2 levels,
CP2000 Center 1 level) represent a problem:

Software Level 1 Level 2 Level 3

MIS (trade-specific soft-
ware)

Job
– Job number
– Job name

Print sheet
– Sheet number
– Sheet name

Operation
– Operation number
– Operation name

Prepress Interface –

CP2000 Center – –

Tab. 4 Depth of the job hierarchy
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The following allocation is used to be able to repre-
sent the 3-level hierarchy of MIS in the CP2000 Cen-
ter: Job number, sheet number and operation num-
ber of the MIS are jointly (with previously defined
delimiters) represented in the job number in CP2000
Center.
Out of job name, sheet name and operation name in
MIS, only the operation name is represented in
CP2000 Center.

Example:

MIS:
– Job number: 1900195
– Job name: Alps
– Sheet number: 01
– Sheet name: MontBlanc
– Operation number: 40
– Operation name: Poster

Representation in CP2000 Center:
– Job number: 1900195/01/40 (with previously de-
fined delimiter ”/”)
– Job name: Poster

The same goes for the 2-level hierarchy of Prepress
Interface.

The individual elements of the job hierarchy are iden-
tified by key words:

Elements of the job
hierarchy

Key word

Job number ORDERNO

Job name ORDERNAME

Sheet number / product
number

SHEETNO / PRODNO

Sheet name / product
name

SHEETNAME / PROD-
NAME

Operation number JOBNO

Operation name JOBNAME

Tab. 5
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Which data is used by CP2000 Management-
Gate?

Section
(see interface description

”Orderinterface
DataControl”)

Attribute Meaning for CP2000 Management-
Gate

Example

Order OrderNo Representation in the ”job” menu is
performed as job ID,separated by a

1900195

ProdNo
performed as job ID,separated by a

defined delimiter (e.g. 01

JobNo
defined delimiter (e.g.

1900195/01/40 with delimiter ”/”) 40

CustomerName Customer Jones

Prodxyz Length Print sheet length in mm (in sheet
traveling direction)

700

Width Print sheet width in mm (at right
angle to the sheet traveling direc-

tion)

1000

PaperGrammage Material thickness
Thickness = PaperGrammage * Pa-

0,25

PaperVolume
Thickness = PaperGrammage * Pa-

perVolume / 1000

Jobabcxyz JobName Job name Poster

Volume Good sheets including plus sheets 8010

MLabcxyz M00 Cost center 3100

Tab. 6

[Header]
SenderID=Heidelberg
Software=CP2000 ManagementGate
Version=01
Release=00

[Order]
OrderNo=1900195
CustomerName=Meier
DeliveryDate=20000331

[Prod000]
ProdNo=01
Width=1000
Length=700
PaperGrammage=135
PaperVolume=1

[Job000000]
JobNo=40
JobName=Poster
Volume=8010

[ML000000]
M00=3100

Fig. 11 Typical file (*.job)

Typical job file (*.job)

The typical file at the left-hand side shows how a file
could look like that is transferred from the MIS to the
file server. Since CP2000 ManagementGate only
processes the data that is listed in the table above,
the data listed under the [Header] section is not
used.

To display the job in job preparation, the [ML000000]
section (cost center) is absolutely necessary. The job
will not be displayed if this section is missing or if the
cost center does not agree with the cost center con-
figured in the CP2000 Center!
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Notes

Job

Job preparation

Printing process

Press configuration

Colour allocation

End of job

Save current job

Printing materialJob designation

job / save current job

name /
rename

host

End of job

ÉÉÉ

12345
job
name

É
É
É

1900195/01/40 Poster Brian

1 2 3

ABC123

Fig. 12 ”Save current job” menu

12/1 Job number

12/2 Job name (JobName)

12/3 Customer (CustomerName)

”OrderNo”, ”ProdNo” and ”JobNo”, separated by the
defined delimiter (”/” in our example), are displayed
as job number. Only ”JobNo” is displayed of ”Or-
derNo” and ”ProdNo” are without contents or if a de-
limiter has not been defined.

[Admin]
OrderNo=1900195
[Text]
==================================
              Control print
==================================
Job number * customer * Cooper Press *

.

.

.

==================================

Fig. 13 Typical job docket file (*.obg)

Typical job docket file (*.obg)

The transmission of a job docket is an option. Any
text can be transmitted. An allocation to the correct
job is only possible if the [Admin] section with the
”OrderNo” attribute exists. The file has the file name
extension ”.obg”.

Notes

Job

Job preparation

Printing process

Press configuration

Colour allocation

End of job

Save current job

Printing materialJob designation

ÉÉÉ

12345
job
name

ÉÉ

==================================

              Control print

==================================

Job number * Customer * Cooper Press *1

Fig. 14 ”Job” menu

14/1 Note pad

The text of the job docket in the [Text] section is dis-
played without any changes in the note pad of the
”Job” menu. Its maximum size is 32 kbytes.
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2.2.3 System properties

Simultaneity

A common file server can be set up for the transfer
of MIS to several CP2000 Centers. In order to avoid
inconsistencies in the job files, only one
CP2000 ManagementGate can access the job data
at any one time. As long as a given file is read by a
CP2000 ManagementGate, it can not be opened by
another CP2000 ManagementGate. In this case, the
process is interrupted and repeated after a short
waiting time. An error message is output at the
CP2000 Center after a configurable maximum wait-
ing time or number of accesses.

Changing the number of available jobs

While CP2000 Center displays a list of the available
jobs, the number of available jobs can change in the
MIS. This can be caused by the MIS itself or by
fetched jobs from other CP2000 ManagementGate
systems. When the user at CP2000 Center chooses
a job, there are two different cases:

� The selected job does not exist in the file ser-
ver. In this case, an error message is output at
the CP2000 Center. 

� The selected job has changed. In this case, the
current job is read, subsequently deleted from
this job file, and written back to the file server.
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2.3 Transferring CP2000 Center production data to the MIS

2.3.1 General information

MIS (vertical market software)

CP2000 ManagementGate

File server

CP2000 Center

PDA data

PDA data

Fig. 15 Transferring PDA data to the MIS

CP2000 ManagementGate can fetch job data from
the MIS and transfer production data to the MIS.
Evaluation and interpretation of the production data
is within the receivers responsibility.

The signal data is converted into the PDA format of
the host interface and continuously written to a file.
Each press has its own unambiguous file name. The
MIS employs this file name to allocate the production
data to the press. MIS renames the PDA file before it
reads it, and deletes it afterwards. Thus, CP2000
ManagementGate always creates the file again if it
does not exist. Otherwise, new messages are ap-
pended at the end.

The number of data records (PDA messages) that is
entered in the file can be configured at the
CP2000 Center. The oldest PDA data is overwritten
when this number is exceeded.

2.3.2 Records

The syntax of the records that are sent from
CP2000 ManagementGate to MIS corresponds to
the syntax that is described in ”DataControl, interface
descriptions, DataControl production data (PDA)”.
There, the meaning of the individual record identifi-
ers is explained in more details. Any CP2000 Man-
agementGate record identifiers without contents will
not be managed by CP2000 Center. Only Record
020 is transferred.
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2.3.3 Process messages in Record 020

Field
no.

Data field Length in
char.

Meaning for CP2000 Management-
Gate

Example

1 Record identifier 6 Number of the record REC020

2 TimeStamp 16 YYYYMMDDHHMMSSHH 20000221123500

3 OrderNo 10 Job number (if the job ID is separated by
a defined delimiter into OrderNo,

ProdNo, and JobNo; otherwise blank)

1900195

4 ProdNo 10 Product number (if the job ID is sepa-
rated by a defined delimiter into Or-

derNo, ProdNo, and JobNo; otherwise
blank)

01

5 JobNo 10 Operation number (if the job ID is sepa-
rated by a defined delimiter into Or-

derNo, ProdNo, and JobNo)

40

Job ID (if the job ID is not separated by
a defined delimiter into OrderNo,

ProdNo, and JobNo)

1900195

6 WorkPlaceNo 10 Configured cost center number 0815/A

7 ActivityNo 20 See table below @49

8 ActivityValue 10 4

9 ActivityName 20 Name of the event Washing inking
rollers

10 Amount 10 Quantity 25000

11 TotalCount 10 Totalizing counter 134527

12 Units 2 Is not transferred

13 Note 80 Is only transferred with manually trans-
mitted PDA messages

Note

14 PersNo 10
mitted PDA messages

15065

15 ProductionTypeNo 10 Is not transferred

Tab. 7
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Predefined events with Record 020

Activity
No.

Activity
Value

Meaning Comment

@17 – Partial ready message. This message is issued automatically by the ma-
chine. It is ensured that at least one partial ready

message is issued inside a selectable interval. The
shortest interval is one minute. New messages will

not be issued when the machine is switched off.

@18 – Production A production interval characterizes a time interval
during which sheets are produced.
�  ”Impression on” in at least one unit

�  ”Ductor on” in this unit
�  ”Sheet travel on”

@47 No. PU Start blanket washup for print-
ing unit no. xx.

Only machines with automatic washup device.

@48 End of blanket washup for print-
ing unit no. xx.

@49 No. PU Start inking roller washup for
printing unit no. xx.

@50 End inking roller washup for
printing unit no. xx.

@51 No. PU Start ink fountain roller washup
for printing unit no. xx.

@52 End ink fountain roller washup
for printing unit no. xx.

@53 No. PU Start of impression cylinder
washup for printing unit no. xx.

@54 End of cleaning impression cyl-
inder of printing unit no. xx.

@95 – Start of the job

@96 – Job interruption

@97 – End of the job The print job is terminated.

@112 – Beginning of the printer’s work-
ing time

@113 – End of the working time

@114 – Beginning of the operator’s
working time

@117 – End of the printing interval Printing interval with good sheets terminated.

@xx – User-defined message

Tab. 8
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3 Connection of CP2000 Center to DataControl

3.1 Presetting Data from DataControl to CP2000 ManagementGate

When a planning result is loaded, the system loads
presetting, ink and repeat data. These data include:

� Order number (OrderNo, ProdNo, JobNo)

� Order name (JobName)

� Customer (CustomerName)

� Good sheets including allowances (Volume)

� Printed sheet length in mm in sheet travel direc-
tion (Length)

� Printed sheet width in mm at right angles to
sheet travel direction (Width)

� Printing sheet thickness (Thickness)

Once the data from DataControl has been loaded,
the jobs are shown in the data list. These are jobs
that were scheduled for this work place on
DataControl. All jobs scheduled for the workplace
group can be displayed when the ”Group” button is
pressed. Currently, the list is limited to the 100 most
recent jobs. Starting with the most recent job, the
jobs are listed from top to bottom.

Press configuration

Run length /
Speed

Job / job preparation

Job preparation / load job

DataControl

Accept job

ÉÉ
É

12345
Job
Name

É
É
É

1900195\01\40 Poster Jones

11 2 3

Group

4

Fig. 16 Data list in the ”Order preparation”
menu

16/1 Order number (OrderNo, ProdNo,
JobNo).

16/2 Order name (JobName)

16/3 Customer (CustomerName)

16/4 ”Group” button

U
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00
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02

00
00

00
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3.2 Process Messages from CP2000 ManagementGate to DataControl

The following data items are transferred from
CP2000 Center to DataControl:

� TimeStamp
Time base

� MachineState
State of the machine (ON, OFF, production
fault, yellow fault, production)

� Amount
Good sheet counter

� TotalCount
Total sheet counter (totalizing counter)

� Speed
Current press speed

� Units
Printing units

� Events (activities)
see table below

3.2.1 Predefined Events (Activities)

Activity
No.

Activity
Value

Meaning Comment

@17 – Partial ready message. This message is issued au-
tomatically by the machine.

@18 – Start of print interval

@47 No. PU Start blanket washup for printing unit no. xx. Only machines with auto-
matic washup device.

@48 End of blanket washup for printing unit no. xx.
matic washup device.

@49 No. PU Start inking roller washup for printing unit no. xx.

@50 End inking roller washup for printing unit no. xx.

@51 No. PU Start ink fountain roller washup for printing unit
no. xx.

@52 End ink fountain roller washup for printing unit no. xx.

@53 No. PU Start of impression cylinder washup for printing unit
no. xx.

@54 End of cleaning impression cylinder of printing unit
no. xx.

@59 – Start of early sheet

@60 – End of early sheet

@61 – Start of misaligned sheet

@62 – End of misaligned sheet

@63 – Start of double sheet

@64 – End of double sheet

@67 – Start of pull error
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CommentMeaningActivity
Value

Activity
No.

@68 – End of pull error

@69 – Start of sheet infeed error

@70 – End of sheet infeed error

@95 – Start of the job

@96 – Job interruption

@97 – End of the job The print job is terminated.

@112 – Beginning of the printer’s working time Although this message is
not transferred to

DataControl, the related
personal number is trans-
mitted with each message.

@117 – End of the printing interval

@xx – User-defined message

Tab. 9




